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Preface

This chapter gives you information about SnapScan, about the organization,
and about how to use this guide.

Chapter1 — Preparing the Scanner

“Preparing the Scanner” explains how to prepare your SnapScan for
installation.

Chapter 2 — Installing the Scanner forPC

This chapter shows you how to set up your SnapScan for your PC.

Chapter 3 — Configuring Buttons on your PC

This chapter shows you how to configure your SnapScan Buttons on your
PC.

Chapter 4 — Installing the Scanner for Macintosh®

This chapter shows you how to set up your SnapScan for your Macintosh.

Chapter 5 — Configuring Buttons on your Macintosh computer.

This chapter shows you how to configure your SnapScan Buttons on your
Macintosh.

Chapter 6 — Making your First Scan

Here you find instructions on how to place reflective originals on the glass
plate of your scanner.

Appendix A — Troubleshooting

“Troubleshooting” can be helpful when you come across problems.

Appendix B — Technical Information on the SnapScan Touch USB Version

This appendix provides specifications for your SnapScan Touch USB
Version.

Appendix C — SnapScan Requlation Compliance

This appendix gives you information about safety regulations and
electromagnetic compatibility.
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About SnapScan

In this Owner’s Guide, the name SnapScan is used forthe SnapScan Touch.

The SnapScan is aone pass flatbed color scanner with aresolution of

600 x 1200 ppiequipped with acold cathode lamp. It is based on CCD (Charge
Coupled Device) scanning technology. With the SnapScan, you can scan line-art,
gray-scale and color reflective originals up to A4 format.

The scanned data is transferred through the computer’'s USB (Universal Serial
Bus) port. The USB technology makes it easy to install multiple peripherals to
your computer. USB eliminates any need to turn off or restart the computer when
attaching anew peripheral.

SnapScan is ascanner that captures and converts reflective originals (for
example pictures, text) into electronic data that can be used in computer
applications. It offers high-resolution image capturing and is an ideal tool in
making presentations come to life.

SnapScan supports multiple scanning modes and includes scanner software to
get you started right away. With its powerful and easy-to-use scanner driver
software, SnapScan gives you easy access to high-quality color scans. The
scanner driver software gives you anumber of additional features to create
special effects orto reproduce even the most difficult originals.

The document cover is adjustable: when you put athick original (like abook or a
magazine) on the reflective glass plate, the document cover adapts to the
thickness of the original.

Environmental Requirements

B Place the scanner on a horizontal, flat surface.

B To ensure proper ventilation, allow a minimum of 10 cm (4 inches) free space
around each side of the scanner.

B Make sure that no vibrations or shocks occur.
[ | Make sure that the areais free of dust.

B Avoid any contact with water. Do not use your scanner near water orin a
damp environment.

B Your SnapScan is designed to perform at best when the environmental
humidity is between 20% and 85%. Avoid environments where humidity
fluctuations might occur.

B Your SnapScan is designed to perform at best when the environmental

temperature is between 10 °C and 40 °C. Avoid exposure to direct sunlight
and heating devices.
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B Checkwhetherthe voltage of the AC adapter corresponds to the voltage in
your area. If it does not correspond, contact your dealer. Avoid environments
where voltage fluctuations might occur.

Precautions

Foryour own safety and that of your equipment, respect conscientiously the
Environmental Requirements and always take the following precautions:

B Check frequently whether there is no overheating of the AC adapter.

B If you do notuse your scanner for some time, pull the AC adapter out of the
power supply socket.

B Handle your SnapScan with care: the glass plate is fragile. There is no
warranty on breaking the glass plate and your dealer is not liable for
consequential damages.

B Disconnectthe AC adapter when you want to clean the scanner housing or
the glass plate and when the scanner needs servicing or repairing.

B Do notopen the scanner housing as it contains high-voltage areas and
sensitive components. Every repair should be carried out by your dealer.

B Do notleave originals on the reflective glass plate for excessive periods of
time. The warmth of the scanner may cause them to deteriorate.

B Forsafety reasons, never use extension cables forthe AC adapter.

Caution: For safety reasons, besides the personal maintenance mentioned in
this Owner's Guide, do not try to remove any mechanical parts or any electronic
components from your scanner. If your scanner needs service, our dealer and
service offices are available to help you.

Cleaning your Scanner

B Cleaning the glass plate regularly, ensures that dirt or smudges do not
reduce the quality of your scanned images.

B Before cleaning, disconnect the AC adapter from your scanner.

B Use asoftdamp cloth and a mild detergent to clean the surface of the glass
plate. If you use alcohol to clean the glass plate, make sure that you do not
touch the plastic elements of the scanner.

B Avoid using sprays directly onto the glass plate as this may cause the liquid
to penetrate the seams around the glass and contaminate the mirrors and
lenses inside the scanner.

B Do notuse liquid cleaners or aerosol cleaners.
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How to Use this Guide

About ShapScan

Environmental Requirements

Precautions

Click any text or graphic that is
identified as hypertext link.

The arrow pointer changes into an
index finger when positioned over a
link.

Underlined textis “linked” to another
part of this guide.

D) PreparingtheScanner
P D Installing the Scannerfor PC
< [ Installingthe Scanner for Macintosh

D) Minimum System Requirements

Click on the bookmark name to go to
the topic marked by that bookmark.
Click the triangle to the left of a
bookmark to show and hide
subordinate bookmarks.

14

d

Use the First Page orlLast Page
button to move the document to the
first or last page of this manual.

44

44

Use the Go Back and Go Forward
buttons to retrace your steps in this
guide, moving to each view in the order
visited.

Use the Previous Page or Next
Page button to move the document
backward or forward, one page at a
time.

You can also use the keyboard arrows.

Use the zoom tool to magnify and
reduce (Control-click) the page display.

&

Click the Find button to search for part
of aword, acomplete word, or multiple
words in this document. You can also
consult the supplied index.

Print

Choose Print from the File menu to
print this online guide.
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How to Print this Guide

Choose Page Setup from the File menu.

Select Orientation: Portrait.

Click OK.

g A W N PP

Choose Print from the File menu.

Choose your paper format from the Paper popup menu.

Preface
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Chapter 1 — Preparing the
Scanner

This chapter helps you to prepare your SnapScan for installation.

Unpacking the Scanner

Taking a Closer Look

How to Change the Handle

Unlocking the Scanner

Chapter 1 — Preparing the Scanner 10



Unpacking the Scanner

1. Openthe packing box and carefully take out all the items.

2. Check each item to make sure that you have everything listed on the box and
on the Packing List. Check if there is no visible defect.
If something is missing, contact your dealer.

3. Remove the plastic wrapping and the packing materials from the scanner.

o,

% Note: Save the packing materials to protect the scanner during later
transport.

Taking a Closer Look

Now that you have the scanner out of the box, take acloserlook so that you
become familiar with its parts. The figures illustrate the locations of the different
parts of your SnapScan Touch.

1. glass plate

2. adjustable document cover
3. print button

4. ocrbutton

5. e-mail button

6. ScanWise button

7. replaceable handle

Chapter 1 — Preparing the Scanner 11
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1. USB port (labeled with the USB icon \P) for connection to your computer
2. AC adapterconnector

How to Change the Handle

It is possible to customize your SnapScan Touch by changing its handle.

1. Pressthe two clips atthe inside of the covertowards each other and lift the
handle.

2. Remove the handle by sliding it out of its lip.

Chapter 1 — Preparing the Scanner 12



3. Choose anew handle.
4. Slide the lip overthe hook.

5. Pressthe clipsin the right position.

Unlocking the Scanner

Before you start using the scanner, you first have to unlock it.

1. Place the scanneron ahorizontal, flat surface and pull it carefully towards
you until you can see the locking slider at the bottom.

2. Slide the locking slider to the right.
Your scanneris unlocked.

Chapter 1 — Preparing the Scanner 13



% Note: If you want to transport your scanner, you have to lock it. To do this,
first connect the AC adapter to the scanner so that its optical assembly

moves to its home position. Then slide the locking slider to the left and

disconnect the scanner. Your scanner is now locked and ready for

transportation.

Caution: Make sure to install the ScanWise software before connecting the
scannerto your PC/Mac.

Chapter 1 — Preparing the Scanner
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Chapter 2 — Installing the
Scanner for PC

This chapter shows you how to set up your SnapScan for your PC.

Minimum System Requirements

Installing the Scanner Software

Connecting the Scannerto your PC

Installing Additional Software

Chapter 2 — Installing the Scanner for PC 15



Minimum System Requirements

A USB port
A Pentium® processor
A 14 inch color monitor

A 16-bit video card for an accurate display of color images (minimum High
Color 16 bit)

32 MB of RAM (64 MB of RAM is recommended)
A CD-ROM drive
Windows® 98

ScanWise is compatible with all IBM™ PCs and compatibles running
Windows 98

The amount of disk space available on your PC determines the number and
the size of the images that you can scan. Make sure that you have enough

free storage space on your hard disk. You need about two times the size of
the image to scan, edit and save it.

Chapter 2 — Installing the Scanner for PC
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Installing the Scanner Software

1. Insertthe Agfa ScanWise CD-ROM in your CD-ROM drive.

% Note: If the ScanWise Installer program does not appear automatically, use
the Windows Explorer to start the installation program.

2. Clickthe up ordown arrow to select your language.

English )

This selection determines the language of the ScanWise software and
documentation.

3. Clickthe up ordown arrow to select yourtype of scanner (if needed).

7 A
SnapScanTouch )

4. Clickthe dotted right arrow or move the slider to “about ScanWise”.

RIS W W i N

language/scanner about ScanWise install

A demonstration of ScanWise will start.

5. Click the dotted right arrow or move the slider to “install”.
6. Click Acrobat Reader to start the installation.

You need Acrobat Reader to read the documentation.

7. Follow the instructions on your screen.

When the installation is finished, the Install screen appears again.
8. Click ScanWise to start the Installation.
9. Followthe instructions on your screen.

When the installation is finished you are ready to connect your scanner to your
PC.

R/

< Note: Forthe latest information refer to the ScanWise Read Me File.

Chapter 2 — Installing the Scanner for PC 17



Connecting the Scanner to your PC

7
*

* Note: Make sure the scanneris unlocked before connecting it to the electric
outlet.

1. Connectthe plug of the AC adapter to your scanner (Figure 1).
2. Plug the adapterin the wall socket.

% Note: Check if it complies with your own power supply.

Figure 1

Chapter 2 — Installing the Scanner for PC 18



3. Connectone end of your USB cable to the USB port on your scanner. Make
sure you connect the correct plug as shown in figure 2.

4. Connectthe otherend of your USB cable to a USB port on your computer.
Make sure you connect it to the correct port as shown in figure 2. A USB port

is labeled with the USB icon \l}

Figure 2

Windows 98 will now detect the scanner and will install the necessary files for
the scanner hardware driver.

Installing Additional Software

If you want to use OCR (Optical Character Recognition) you will have to install
OmniPage. To do so, insert the Caere CD-ROM and follow the instructions on
your screen.

To install additional software, insert the Corel CD-ROM and follow the
instructions on your screen.

If the Installer Program does not appear automatically, use the Windows Explorer
to start the installation.

Forageneral overview of the possible workflows and to see how the software
works together, please refer to the Navigation Map which is supplied with your
scanner.

Chapter 2 — Installing the Scanner for PC 19



Chapter 3 — Configuring Buttons
on your PC

Selecting a Different ScanWise Configuration

Modifying an Existing Configuration

Creating anew Configuration

Modifying the ScanWise Settings

Chapter 3 — Configuring Buttons on your PC 20



Selecting a Different ScanWise
Configuration

It is possible to assign a different configuration to the print, ocr and e-mail
button. Following example will show you how it is done.

In this example we will change the settings of the ocr button into a configuration
that will send the scanned image to afile.

1. Openthe Agfa ScanWise software.

2. Select ‘Configure Buttons...' fromthe Tools menu.
The Configure Buttons window appears.

Confguoutons G|
-\
d —) l )j ICoIorCopyfuII page _'_j

b ”)
i )\ Scan Text to Microsoft Word 97

I >
y

™

’) ISend Image to Mail recipient :J

oK Cancel Organize... I

a. print button

b. ocr button

c. e-mail button
3. Clickthe drop-down list next to the ocr button.
4. Select‘'Scan Image to File (autoselect)’.
5. Click ‘OK".

Pushing the ocr button will send the scanned image to afile instead of to
your word processor.

% Note: The same procedure can be applied to the print and e-mail button.

Chapter 3 — Configuring Buttons on your PC 21



Modifying an Existing Configuration

It is possible to modify an existing configuration and assign it to the print, ocr and
e-mail button. Following example will show you how itis done.

In this example we will change the settings of the ocr button into a configuration
that will send the scanned image to afile. Furthermore we will modify this
configuration by calling on the PhotoGenie software to optimize the colors of our
image.
1. Openthe Agfa ScanWise software.
2. Select ‘Configure Buttons...' fromthe Tools menu.

The Configure Buttons window appears.

Confguoutons G|
-\

a8 —r 0T ) ) Color Copy full page v
j N

b - ’)\
i o )\ Scan Text to Microsoft Word 97

3 D"
¢ ‘)) ISend Image to Mail recipient :_l
\ -

oK Cancel Organize... l

a. print button
b. ocr button
c. e-mail button

3. Clickthe ‘Organize...’button.
The Organize Actions window appears.

Chapter 3 — Configuring Buttons on your PC 22
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Organize Actions Kl E3 |

—Actions
Color Copy full page New...
Gray Copy full page
Line Art Copy full page Edit...
Scan Image to File (fixed selection)
Scan to Adobe Photoshop 5.0 (fixed selection) Remove...

Scan to Web Image

Scan Image to Microsoft Word 97 (fixed selection)
Send Image to Mail recipient

Scan Image to Microsoft Word 97 (autoselect)

gScan Image to File (autoselect)
Scan Text to Microsoft Word 97
Send Text to Mail recipient
Scan to Adobe Photoshop 5.0 (autoselect)
Scan Textto File

Close

The Organize Actions window displays all predefined and user defined
configurations.

Note: The ‘Remove...” button will be enabled when auser defined action is
selected. The default actions cannot be removed.

Select ‘'Scan Image to File (autoselect)’.

Click ‘Edit... ‘to modify the selected configuration.
The ‘Settings For...” window appears.

Chapter 3 — Configuring Buttons on your PC 23



Settings For Scan Image to File [autoselect) 2| x|
Selection: IAutoseIect originals Ll
a
Original Type: IPhOtO-glOSS}f j
Destination: IF“e j
Color Mode: IAutodetect zl
[V iUse PhotoGenie:
b Resolution: 150 dpi
¢ Dimension: IKeep original size Ll
oK Cancel Save As ... |

a. All predefined settings are available via the different drop-down menus.
b. The Resolution depends on the choice of Destination.

c. The output dimensions can be managed viathe Dimension drop-down
list.

7
*

* Note: There are several options to edit the existing configuration. For more
information refer to the ‘Modifying the ScanWise Settings’ section in this
Owner’'s Guide.

6. Clickthe ‘Use PhotoGenie’' checkbox.

The color and detail of your design will be optimized.

7. Click ‘Save As...’
The Save Action Configuration window appears.

Save Action Configuration 2| x|

Action Name:
IMy Scan Image to File (autoselect) j Cancel |

8. Enterthe name of your configuration.
9. Click ‘'OK".
You return to the ‘Settings For...” window.

10. Click ‘OK".

Chapter 3 — Configuring Buttons on your PC
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You return to the Organize Actions window and your configuration will be
added to the Actions list.

11. Click ‘Close’.
You return to the Configure Buttons window.

12. Select ‘My Scan Image to File (autoselect)’ from the drop-down list next to
the ocr button.
13. Click ‘OK".

Pushing the ocr button will send the scanned image to afile instead of to
your word processor. The PhotoGenie software will optimize the colors of
your image.

Creating a new Configuration

It is possible to create anew configuration and assign it to the print, ocr and e-
mail button. Following example will show you how itis done.

In this example we will create a new configuration and assign it to the ocr button.

1. Openthe Agfa ScanWise software.

2. Select ‘Configure Buttons... * from the Tools menu.
The Configure Buttons window appears.

Confgure Butons g |
_ AN

a8 —m = ) ) Color Copy full page b
e

b - ’)\
i ~ )\ Scan Text to Microsoft Word 97

-~ )\)
¢ J ) Send Image to Mail recipient v
-~ | =]

oK Cancel Organize... l

a. print button
b. ocr button
c. e-mail button

3. Click the ‘Organize...’button.
The Organize Actions window appears.

Chapter 3 — Configuring Buttons on your PC
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The Organize Actions window displays all predefined and user defined

— Actions

Organize Actions Kl E3 |

Color Copy full page

Gray Copy full page

Line Art Copy full page

Scan Image to File (fixed selection)

Scan to Adobe Photoshop 5.0 (fixed selection)
Scan to Web Image

Scan Image to Microsoft Word 97 (fixed selection)
Send Image to Mail recipient

Scan Image to Microsoft Word 97 (autoselect)

iScan Image to File (autoselec

Scan Text to Microsoft Word 97

Send Text to Mail recipient

Scan to Adobe Photoshop 5.0 (autoselect)
Scan Textto File

New...

Edit...

HEMOVE..,

Close

configurations.

o
£

Click ‘New...” in the Organize Actions window.
The ‘Settings For...” window appears.

Note: The ‘Remove...” button will be enabled when auser defined action is
selected. The default actions cannot be removed.

Chapter 3 — Configuring Buttons on your PC
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Settings For Untitled 7] X |

Selection:
Select Full Scanbed b
a I _I
Original Type: IPhoto-gIossy LI
Destination: lrne LI
Color Mode: Icolor EI
[T Use PhotoGenie:
b Resolution: 150 dpi
¢ Dimension: IKeep original size ;I
Cancel Save As ... |

a. All predefined settings are available via the different drop-down menus.

b. The Resolution depends on the choice of Destination.

c. The output dimensions can be managed viathe Dimension drop-down
list.

Note: There are several options to create a new configuration. For more
information refer to the ‘Modifying the ScanWise Settings’ section in this
Owner’'s Guide.

Select the settings that you want to apply.
Click ‘Save As...’

The Save Action Configuration window appears.

Save Action Configuration 2] x|

Action Name:

I My configuration El Cancel |

Enter the name of your configuration.
Click ‘OK".
You return to the ‘Settings For...” window.

Click ‘OK".
You return to the Organize Actions window and your configuration will be
added to the Actions list.

Chapter 3 — Configuring Buttons on your PC
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10.

11.
12.

Click ‘Close’.

You return to the Configure Buttons window.

Select ‘My configuration’ from the drop-down list next to the ocr button.
Click ‘OK".

The ocr button will apply your personal settings.

Chapter 3 — Configuring Buttons on your PC
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Modifying the ScanWise Settings

There are several options to edit an existing configuration or to create anew
one.

In the ‘Settings For ...” window following options are available:

Settings For Untitled 2]

Selection: ISeIect Full Scanbed El
Original Type: |Photo-g|ossy E|
Destination: Iri|e El
Color Mode: IColor j

l_ Use PhotoGenie:

Resolution: 150 dpi

Dimension: IKeep original size j

Cancel Save As ... |

B Selection, Original Type, Destination and Color Mode can be changed using
the different drop-down menus.

B Clickthe checkbox ‘Use PhotoGenie’ if you want to activate the PhotoGenie
software that optimizes both color and detail of your scanned image.

B The resolution depends on the destination. If you select your printer as a
destination, the resolution of your printer destination will be shown in the
Resolution box.

Chapter 3 — Configuring Buttons on your PC 29



If you want a specified output range, click the Dimension drop-down list. A

list of additinal options will appear. Select the dimension (width or height)

you want to specify. Enterthe desired range and select the correct unit from
the drop-down list. The ‘Keep original size’ selection will keep the original

size of the image.

Dimension:

Height:

oK

[Scale to fixed height -
I 15 | |Inches El
Inches
calPixels
{Millimeters

Chapter 3 — Configuring Buttons on your PC
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Chapter 4 — Installing the
Scanner for Macintosh

This chapter shows you how to set up your SnapScan for your Macintosh.

Minimum System Requirements

Installing the Image Editing Software

Installing the Scanner Software

Connecting the Scannerto your Macintosh Computer

Installing Additional Software
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Minimum System Requirements

A USB port

A PowerPC® processor

A 14 inch color monitor with thousands of colors for an accurate display of
color images

32 MB of RAM

A CD-ROM drive

Mac OS 8® or higher

Installing the Image Editing Software

N o o~ wWwDN

Disable the virus protection software.

You can turn it off in the Extensions Manager Control Panel or you can drag
the software out of the System Folder.

% Note: Afterinstalling, enable the virus protection software again.
Restart your computer.

Insert the Agfa ScanWise CD-ROM.

Double-click the Color It! folder to open it.

Double-click the language folder of your choice.

Double-click the Install Color It! icon to start the program.

Make your choice in every successive screen to install Color It!™ (the image
editing software).

Chapter 4 — Installing the Scanner for Macintosh
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Installing the Scanner Software

1. With the Agfa ScanWise CD-ROM still in the CD-ROM drive, double-click the
Agfa ScanWise Installer icon.

2. Clickthe up ordown arrow to select your language.

English )

This selection determines the language of the ScanWise software and
documentation.

3. Clickthe up ordown arrow to select yourtype of scanner (if needed).

7 A
SnapScanTouch )

4. Click the dotted right arrow or move the slider to “about ScanWise”.

R I e A R ) e e P e P P 2 e 7] IR

language/scanner about ScanWise install

A demonstration of ScanWise will start.

5. Click the dotted right arrow or move the slider to “install”.
6. Click ScanWise to start the installation.

7. Follow the instructions on your screen.

When ScanWise is installed, you may be asked to restart your computer. In
this case, repeat step 1 to 3 before continuing this procedure. Then click the
dotted right arrow or move the slider to “install”.

8. Click Acrobat Reader to start the installation.
You need Acrobat Reader to read the documentation.

9. Followthe instructions on your screen.
When Acrobat Reader is installed you will be asked to restart your computer.

When the installation is finished you are ready to connect your scanner to your
Macintosh computer.

o

<+ Note: Forthe latest information, refer to the ScanWise Read Me File.
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Connecting the Scanner to the
Macintosh Computer

% Note: Make sure the scanneris unlocked before connecting it to the electric
outlet.

1. Connectthe plug of the AC adapter to your scanner (Figure 1).
2. Plug the adapterin the wall socket.

% Note: Check if it complies with your own power supply.

=L

,h
W
1

Figure 1
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3. Connectone end of your USB cable to the USB port on your scanner.
Make sure you connect the correct plug as shown in figure 2.

4. Connectthe otherend of your USB cable to a USB port on your computer.
Make sure you connect it to the correct port as shown in figure 2. A USB port

is marked with the USB icon ‘l}

Figure 2

Installing Additional Software

If you want to use OCR (Optical Character Recognition) you will have to install
OmniPage LE. To do so, insert the Caere CD-ROM and follow the instructions on
your screen.

Forageneral overview of the possible workflows and to see how the software
works together, please refer to the Navigation Map which is supplied with your
scanner.
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Chapter 5 — Configuring Buttons
on your Macintosh Computer

Selecting a Different ScanWise Configuration

Modifying an existing Configuration

Creating anew Configuration

Modifying the ScanWise Settings
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Selecting a Different ScanWise
Configuration

It is possible to assign a different configuration to the print, ocr and e-mail
button. Following example will show you how it is done.

In this example we will change the settings of the ocr button into a configuration
that will send the scanned image to afile.

1. Openthe Agfa ScanWise software.

2. Select ‘Configure Buttons... ‘ from the Tools menu.
The Configure Buttons window appears.

Configure Buttons

a ___’) i )) | Color Copy full page 4]

b _T"); )) | Scan Text to Microsoft Word ¢]

c ) l\') [ Send Image to Mail recipient =

[ oOrganize.. | [ cancel || 0K |

a. print button

b. ocr button

c. e-mail button
3. Clickthe popup list next to the ocr button.
4. Select ‘'Scan Image to File (autoselect)’.
5. Click ‘'OK".

Pushing the ocr button will send the scanned image to afile instead of to
your word processor.

% Note: The same procedure can be applied to the print and e-mail button.
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Modifying an Existing Configuration

It is possible to modify an existing configuration and assign it to the print, ocr and
e-mail button. Following example will show you how it is done.

In this example we will change the settings of the ocr button into a configuration
that will send the scanned image to a file. Furthermore we will modify this
configuration by calling on the PhotoGenie software to optimize the colors of our
image.

1. Openthe Agfa ScanWise software.

2. Select ‘Configure Buttons...' from the Tools menu.
The Configure Buttons window appears.

Configure Buttons

a _——’) )\)) | Color Copy full page ¢

N

e\
b __T—l )) | Scan Text to Microsoft Word %)

N\

c % ‘)\’) | Send Image to Mail recipient =

[ oOrganize.. | [ cancel || 0K |

a. print button

b. ocr button
c. e-mail button

3. Clickthe ‘Organize...’button.
The Organize Actions window appears.
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Organize Actions

Color Copy full page Actions

Gray Copy full page

Line Art Copy full page

Jun »

Scan Image to File {autoselect)

Scan Image to File (fixed selection)

Scan Image to Microsoft Word {(autoselect)

Scan Image to Microsoft Word (fixed selection)
Scan Text to File

Scan Text to Microsoft Word

Scan to Adobe® Photoshop® 5.0.2 (autoselect)
Scan to Adobe® Photoshop® 5.0.2 (fixed selection)
Scan to Web Image

| Remove...

4

The Organize Actions window displays all predefined and user defined
configurations.

o

< Note: The ‘Remove..." button will be enabled when auser defined action is
selected. The default actions cannot be removed.

4. Select‘'Scan Image to File (autoselect)’.

5. Click ‘Edit... ‘to modify the selected configuration.
The ‘Settings For...” window appears.

Settings For Scan Image to File (autoselect)

Selection: [ AutoSelect originals ﬂ
a |

Original Type: [ Photo-glossy ﬂ

Destination: [ File El

Color Mode: [ Autodetect ﬂ

(4 Use PhotoGenie:

b — Resolution: dpi

¢ —- Dimension: [ Keep original size 2)

| Cancel ||| OK ||

a. All predefined settings are available via the different popup menus.

b. The Resolution depends on the choice of Destination.

c. The output dimensions can be managed viathe Dimension popup list.
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10.

11.

12.

13.

Note: There are several options to edit the existing configuration. For more
information refer to the ‘Modifying the ScanWise Settings’ section in this

Owner's Guide.

Click the ‘Use PhotoGenie’ checkbox.
The color and detail of your design will be optimized.

Click ‘Save As...’

The ‘Save Action Configuration’ window appears.

Save Action Configuration

Action Name:

My Scan Image to File (autoselect)

| Cancel I | 0K l

Enter the name of your configuration.

Click 'OK".

You return to the ‘Settings For...” window.

Click ‘OK".

You return to the Organize Actions window and your configuration will be

added to the Actions list.

Click ‘Close’.

You return to the Configure Buttons window.

Select ‘My Scan Image to File (autoselect)’ from the popup list next to the ocr

button.

Click ‘OK".

Pushing the ocr button will send the scanned image to afile instead of to
your word processor. The PhotoGenie software will optimize the colors of

your image.

Chapter 5 — Configuring Buttons on your Macintosh Computer

40



Creating a New Configuration

It is possible to create anew configuration and assign it to the print, ocr and e-

mail button. Following example will show you how itis done.

In this example we will create a new configuration and assign it to the ocr button.

1. Openthe Agfa ScanWise software.

2. Select ‘Configure Buttons...” from the Tools menu.
The Configure Buttons window appears.

Configure Buttons

a __’) )\)3 | Color Copy full page

2)

N

B

b _—T':); )) | Scan Text to Microsoft Word

N
c % l) [ Send Image to Mail recipient

B

[ organize.. | [ cancel || 0K |

a. print button
b. ocr button
c. e-mail button

3. Click on the ‘Organize...” button.
The Organize Actions window appears.
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Organize Actions

Color Copy full page Actions

Gray Copy full page

Line Art Copy full page

fuifv

Scan Image to File {(autoselect) Edit
Scan Image to File (fixed selection)
Scan Image to Microsoft Word {(autoselect)

Scan Image to Microsoft Word (fixed selection)
Scan Text to File

Scan Text to Microsoft Word

Scan to Adobe® Photoshop® 5.0.2 (autoselect)
Scan to Adobe® Photoshop® 5.0.2 (fixed selection)
Scan to Web Image

| Remove...

l

The Organize Actions window displays all predefined and user defined
configurations.

®,

< Note: The ‘Remove...” button will be enabled when auser defined action is
selected. The default actions cannot be removed.

4. Click ‘New..." in the Organize Actions window.
The ‘Settings For...” window appears.

Settings For Untitled
Selection: [ Select Full Scanbed i]
a ——
Original Type: [ Photo-glossy El
Destination: [ File i]
Color Mode: [ Color =

[J Use PhotoGenie:

b L Resolution: dpi

C —1 Dimension: [ Keep original size E

[ saveas.. | (_cancel | || 0K I

a. All predefined settings are available via the different popup menus.
b. The Resolution depends on the choice of Destination.

c. The output dimensions can be managed viathe Dimension popup list.
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10.

11.
12.

Note: There are several options to create a new configuration. For more
information refer to the ‘Modifying the ScanWise Settings’ section in this
Owner’'s Guide.

Select the settings that you want to apply.

Click ‘Save As...’
The ‘Save Action Configuration’ window appears.

Save Action Configuration

Action Name:

My Configuration

| Cancel ] | 0K l

Enter the name of your configuration.
Click 'OK".
You return to the ‘Settings For...” window.

Click ‘'OK".
You return to the Organize Actions window and your configuration will be
added to the Actions list.

Click ‘Close’.

You return to the Organize Actions window.

Select ‘My Configuration’ from the popup list next to the ocr button.
Click ‘OK".

The ocr button will apply your personal settings.
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Modifying the ScanWise Settings

There are several options to edit the existing configuration or to create a new
one.

In the ‘Settings For...” window following options are available:

Settings For Untitled

Selection: [ Select Full Scanbed ﬂ
Original Type: [ Photo-glossy ﬂ
Destination: | File =
Color Mode: | Color EX

[J Use PhotoGenie:

Resolution: dpi

Dimension: | Keep original size 2]

[ saveas.. | |__cancel | | oK |

B Selection, Original Type, Destination and Color Mode can be changed using

the different popup menus.

B Clickthe checkbox ‘Use PhotoGenie’ if you want to activate the PhotoGenie

software that optimizes both color and detail of your scanned image.

B The resolution depends on the destination. If you select your printer as a
destination, the resolution of your printer destination will be shown in the

Resolution box.
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If you want a specified output range, click the Dimension popup list. A list of

additional options will appear. Select the dimension (width or height) you

want to specify. Enter the desired range and select the correct unit from the

popup list. The ‘Keep original size’ selection will keep the original size of the

image.

Dimension:

Width:

[ Scale to fixed width

| Save As ..

v Centimeters
Millimeters
Inches
Pixels

O
[J
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Chapter 6 — Making your First
Scan

=Y

5.
6.

Place a color photograph face down on the glass plate with the top side
against the middle of the front ruler.

The optical performance of a CCD scanner is always best near the middle of
the glass plate. However, the specified scan quality is guaranteed for the
entire scan area.

If you put more than one original on the glass plate, position them as close to
the centerline as possible to optimize quality.

Lower the document cover of the scanner.

% Note: The adjustable document cover makes it possible to scan from
books and magazines. When you put athick original on the reflective
glass plate, the document cover adapts to the thickness of the original.

Double-click the Agfa ScanWise application icon on your Macintosh computer
or select Programs, Agfa ScanWise in the Start menu on your PC.

Select your scanner (if needed).
% Note: This dialog only appears the first time you use ScanWise.
Click ‘Yes’ when the system asks to guide you.

Follow the steps described in the ScanWise Guide Me mode.

For more information refer to the ScanWise Application Guide and the Technical
Support document (here you find all Agfalocal support centers and other
software suppliers).

R/
0.0

Note: If you encounter problems, please referto the ScanWise Read Me file
on your computer orto the Troubleshooting section in this Getting Started.

Chapter 6 — Making your First Scan 46



Appendix A — Troubleshooting

This section gives solutions for some common problems you may come across
when starting up or using your SnapScan Touch.

There’s no USB port free for your scanner.

B Checkif you can use a USB porton the keyboard or monitor.

B Use aUSB hub.

The scanner makes an unusual noise and the scanner lamp
does not move back and forth when you connect the
scanner.

B The scanner was not properly unlocked. Immediately disconnect the AC
adapter and unlock the scanner properly, or contact your dealer or local Agfa
support center.

The scanner lamp flickers, dims, or fails to come on.

B The cold cathode lamp needs to be replaced. Contact your dealer or local
Agfasupport center.

ScanWise cannot find the scanner.

If the scanner driver cannot find the scanner, a message appears telling you that
no scanneris connected.

B Checkifthe scanneris connected with the USB cable to your computer and
that the AC adapter is plugged in. It can always happen that a USB port is
damaged, therefore try the other USB port of your computer.

B Ensure the scanneris powered on.

| (MACINTOSH ONLY)
Open the Apple System Profiler that you find under the O menu. Click the
tab ‘Devices and Volumes’ (minimum version 8.5). Here you can check if the
USB device is found. If USB is not present in the list of ‘Devices and
Volumes’, please check the hardware (cable, USB ports, ...).

B Disconnectthe AC adapter and reconnect it again.

% Note: If you encounter other problems during or after installation, please
referto the ScanWise Read Me file on your computer.
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The driver is not found when you connect the scanner to
your computer (MACINTOSH ONLY).

If ScanWise is not installed correctly, the following message appears: “The
software needed to use the device SnapScan Touch cannot be found”.
B Re-install ScanWise.

B Checkif the Extensions folder contains the file ‘Agfa USB Touch’. This driver
is necessary for detecting the scanner.

When windows 98 fails to detect the scanner when you
connect it for the first time (PC ONLY).

B Checkif the scanneris connected with the USB cable to your computer and
that the AC adapteris plugged in. It can always happen that a USB port is
damaged, therefore try the other USB port of your computer.

B Check if the Device Manager finds the USB controller. To check if the USB
controlleris present in the Device Manager, click with the right mouse button
on the icon My Computer and select Properties from the menu that pops up.
Select the Device Manager tab from the System Properties dialog box.

O If the USB controller (*<=*) is present in the Device Manager, carry out
the scannerinstallation procedure exactly as described in this manual.

O Ifthe USB controlleris not presentin the Device Manager, carry out the
following instructions:

1. Restart your computer.

2. Enable the USB controllerin the BIOS settings.

Caution: Changing your computer’'s BIOS settings is at your own risk! It
should be done by system administrators and experienced users only. If you
are not familiar with these tasks, ask your computer dealer to do this for you.

You typically do this by pressing a key combination during the startup of
your PC. Referto your computer manual for more information.

3. Exit and save the changes you made.
Your computeris rebooted automatically.

B Check again if the Universal serial bus controller is present in the Device
Manager.

O If the Universal serial bus controller (*<=*) is present in the Device
Manager, carry out the scanner installation procedure exactly as
described in this manual.

O If the Universal serial bus controller is still not present in the Device
Manager, carry out the following instructions:

1. Click the Start button.
2. Select Settings.
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3. Select Control Panel.
4. Double-click on the Add New Hardware icon.
5. Attentively follow the instructions that appear on your screen.

The Universal serial bus controller should now be present in the Device Manager.
Carry out the scanner installation procedure exactly as described in this manual.

A OEM Windows 98 system was already installed when
purchasing your computer.

When you encounter problems during the installation procedure on a PC with a
pre-installed Windows 98 system, please contact your PC dealer.
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Appendix B — Technical

Information

Technical specifications are subject to change without notice.

Scanner type:

Desktop, flatbed, one pass, 4buttons of
which 3 are Software definable

Maximum resolution:
- optical:

- through interpolation:

600 ppi horizontal x 1200 ppi vertical
9600 ppi horizontal x 9600 ppi vertical

Internal sample depth:

12 bits for gray, 48 bits for color

Scanning speed:
- line-art:
- gray:

- color:

5ms/ line
5ms/line

10 ms/ line

Maximum scanning area:

216 x 297 mm (8.5 " x11.7 ")

Lamp:

cold cathode

Power-on to ready time:

< 15 seconds

Power supply:
- voltage:

- frequency:

100 to 240 V
47 to 63 Hz

Range of Voltage and frequency depends on
your country’s power supply.

Power consumption: 30w
Dimensions:

- length: 445 mm

- width: 292 mm
- height: 100 mm

- weight: ca. 3.2 kg
Interface: USB port

Transmission speed:

0.94 mbytel/s

Environmental
specifications:

- operating temperature:

- relative humidity:

-surrounding space:

+10 °C to +40 °C (+50 to +104 degrees
Fahrenheit)

20% to 85% RH

10 cmon every side
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Appendix C —Regulation
Compliance

Safety Regulations

Electromagnetic Compatibility
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Safety Regulations

SnapScan and its options are designed to comply with:

B UL 1950

B CSAC22.2 No.950-M89 D3
B VDE 0805

B |[EC950

B GS approved

B ENG60950

UL Safety Statement

The SnapScan and the AC adapter are suited forindoor use only. Do not use
them outdoors.

Use the Agfa supplied AC adapter only. Otherwise guarantee will be voided.

Forthe reason of safety, besides the personal maintenance mentioned in this
operation manual, do not try to remove any mechanical parts or any electronic
devices. If your scanner needs service, our dealer and service offices are
available to help you.

TUV: Wichtige Sicherheitshinweise

1. Bitte Lesen Sie sich diese Hinweise sorgfaltig durch.

2. Umeine Beschadigung des Geréates zu vermeiden sollten Sie nur
Zuberhdrteile verwenden, die vom Hersteller zugelassen sind.

3. Das Gerat ist vor Feuchtigkeit zu schitzen.

4. Beider Aufstellung des Gerétes ist auf sicheren Stand zu achten. Ein
Kippen oder Fallen kénnte Verletzungen hervorrufen. Verwenden Sie nur
sichere Standorte und beachten Sie die Aufstellhinweise des Herstellers.

5. Die Beluftungsdéffnungen dienen zur Luftzirkulation die das Geréat vor
Uberhitzung schiitz. Sorgen Sie dafiir, daR diese Offnungen nicht
abgedeckt werden.

6. Die NetzanschluRsteckdose mufd aus Grilnden der elektrischen Sicherheit
einen Schutzleiterkontakt haben.

7. Durch die Liftungsoéffnungen durfen niemals Gegenstande oder
Flissigkeiten in das Gerat gelangen. Dies kdnnte einen Brand bzw.
elektrischen Schlag auslésen.

8. Offnen Sie niemals das Geréat. Das Gerét darf aus Griinden der elektrischen
Sicherheit nur von authorisiertem Servicepersonal gedffnet werden.

9. Die Steck dose sollte nahe dem Gerat und leicht zugéanglich sein.
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Electromagnetic Compatibility

SnapScan is designed to comply with:

[ | Emission EN55022, class B
B Immunity IEC 801-2,IEC 801-3,IEC 801-4

B 47 CFR, part 15, subpart B, class B

Federal Communications Commission Radio
Frequency Interference Statement

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment
is operated in aresidential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and
on, the useris encouraged to try to correct the interference by one or more of
the following measures:

B Reorient orrelocate the receiving antenna.
B Increase the separation between the equipment and receiver.

B Connectthe equipmentinto an outlet on a circuit different from that to which
the receiveris connected.

B Consultthe dealer or an experienced radio/television technician for help.

Industry Canada Class A and B Label
Requirements

This Class [select A or B] digital apparatus meets all the requirements of the
Canadian Interference Causing Equipment Regulations.

Cet appareil numérique de laclasse [A/B] respecte toutes les exigences du
Réglement sur le matériel brouilleur du Canada.
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